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Terms and data structures

• You can create and manage different projects

• Projects can contain different report collections

• These report collections represent the meeting groups (e.g. construction meeting, 
client meeting, project meeting, jour fixe, memo,...). 

• In the report collection you can find the reports (meetings). On this level you find 
the report items

Report collection

Report items

reports

1. Menu control and masks

When PROMAN X is started, the "Open 

project" dialog opens. You can open a 

project by double-clicking on it. With (3) 

you can search for a specific project.

You can mark your important projects

with the favorite star (2). If checked, 

only the favorites are displayed. 

To show all again, please click on the

favorite star (1)
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1.1 menu control and masks

You can control the application 

using :

- Right Mouse 

- Upper menu items

- tool kit

and select the desired function

1.1 menu control and masks

(1) Project tree with all 

report collections and 

reports

(2) Address data (central

or in the project, 

visible by the

heading)

(3) project addresses

(4) Toolbox with the most

important functions

of the current mask
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1.1 menu control and masks

The mask elements

can be repositioned

using drag & drop.

If you can't find a window

anymore, you can simply

reset the arrangement to

the original state. 

2. Create project

• With a right mouse click on a 
project you can create a new
project.
• Project short name: This represents

a unique key for this project (e.g. 
accounting number) (see 1).

• Project long name: Here you will 
find 
the project name
(see 2).

• All other fields are optional.
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2. Create project

• With the wizard you can make
the following selections:
• Edit Project Details: In this mask

you can enter and edit all 
details such as logo, 
description, project code (see 1).

• Copy Structure from existing
project: This takes you directly
to the "Project Template"
screen to transfer data (logo, 
report collections, chapters, 
texts, etc.) from existing
projects (see 2).

2.1 project general data in printout
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2.2 project logo

• Within the project you can
immediately design your
header and footer bar.

• First choose your logo 
(see 1)

• define the width and height of
your logo in the printout (see
2)

• under alignment you define
the placement of your logo 
(see 3)

• A text field can be added in 
the text editor

2.3 project template

• Enables you to quickly and 
easily transfer all essential 
settings and structures from a 
"template project" (see 1):
• Header and footer bar
• Project general data
• project partner
• Report collections

• with chapter
• with distributor

• text blocks
• attributes

• With the button "all data
without project partner" (see
2) you can quickly transfer all 
structural data without project
participants.
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3. addresses in printout

• Addresses are required for the
• Participants list (cover page)

• Involved (per report items)

• session dates
• chairman

• writer

3.1 central address management
Under Tools -> show central addressbook, you
can access the central address management.

• Enables the cross-project storage of addresses

• Addresses can easily be transferred to the projects

Companies and their employees can be defined
centrally. This data is used for:

• Participants and distributors of meetings

• Automatic sending of reports with e-mail

• Assignment of involved persons / responsible persons
to points
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3.1 central address management

In the central address
book, you can manage all 
companies and employees
in order to assign them to
the desired projects in the
next step. 

The settings made here
apply globally to all 
projects by setting a 
standard. 

Features of the central
administration:
• Classic search: Search for

companies and persons
(see 1)

3.1 central address management
Toolbox on top:

• Create, edit and delete
Companies and employees
(see 2)

• Manage functions for
companies
and employees (see 3)

• Attributes can be assigned to
company employees and 
report items (see 4).

• Excel Import / Export & PDF 
Export / Outlook and Access 
Synchronization (see 5)

• Employees can be copied to
another company. This does
not delete the existing record. 
(see 6)
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3.1 central address management

Toolbox at the bottom:

• With the button „show
disabled records" you can
select whether data records
that have been archived
should be displayed. If the
button is blue, the display of
archived data is activated. (see
7)

• In addition to the classic 
search, the user-defined filter
allows you to refine your
search with a variety of
criteria and to display filtered
address lists.

3.2 address management: Company 
data

• Add the logo of the created
company as jpg, gif or png (see
1)

• Import option from Outlook via 
drag&drop: After creating the
company, further employees
can be dragged into this field 
for automated creation (see 2).

• Company short- & long name -> 
The short name is unique and 
can only be assigned once.
(see 3)

Under Address management central -> Create company
you can create a new company
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3.2 address management: Company 
data

• Address information (see 4) 
In the case of "secondary
location of", this is indicated
on the printout.

• Departments with short and 
long name. The department is
assigned via "Add". The 
department is displayed for
selection by the relevant 
employees. (see 5)

• Attributes can be assigned via 
"Manage attributes". (see 6)

Under Address management central -> Create company you
can create a new company.

3.2 address management: Company 
data

• Telephone numbers & e-mail
address of the company -> 
suggestions for employees are
generated automatically. The 
telephone number and e-mail
address selected as default will 
be used for the printout. (see 7)

• Functions with short and long
name. The "Add" button takes
you to the function manager for
company functions, where new
functions can be created. These 
are then displayed for selection
in the dropdown menu. (see 8)

• Now click on Save (see 9) to save 
the entries.
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3.3 address management: empyees
each firm

• Import option from Outlook via 
drag&drop (see 1)

• Short - the short name must be
unique and can only be
assigned once. (see 2)

• Last name, first name (see 3)

• Gender / Title (see 4)

• Title can be used for the long
name. (see 5) This can be
printed e.g. on the cover sheet
in the distributor.

You can create a new employee under Address Management Central -> 
Create Employee. 

• Departments that were previously created
at the associated company can be
selected here. (see 6)

• Functions with short and long name. The 
"Add" button takes you to the function
manager for the employee functions, in 
which new functions can be created. 
These are then displayed for selection in 
the dropdown menu. (see 7)

• Attributes By clicking on "Manage 
Attributes" you can select and add
available attributes. (see 8) 

You can create a new employee under Address Management 
Central -> Create Employee.

3.3 address management: Employees
each company
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• Telephone number & e-mail (see 9) is
used for automatic e-mail dispatch
via the local e-mail client (Outlook, 
Lotus Notes, ...). The telephone
number entered in the company is
prefilled by the employee and can
therefore be adapted quickly. From
the first and last name, the address
administration automatically
suggests e-mail addresses in 
combination with the entered
company e-mail address. 

• Now click OK (see 10) to save.

You can create a new employee under Address Management Central -> 
Create Employee.

3.3 Address management: Employees
per company

3.4 Address management: Advantages of
naming the company with short form

• short

Allows a space-saving printout of the
company name and person

• best practice
• The short should also enable an 

external company / person to
recognize the participant.
• Name e.g. Roland Pezzei 

Short name Pezzei

• Company e.g. PROMAN Software GmbH 
Short name PROMAN

• Long is entered in the field:
• Long 

• person
• First name

• Surname

• title
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3.5 Company/employee functions
Functions are often used for the
representation of the functions/works
of the
Companies and employees.

Create (see 1) and edit the functions is
easily accessible from the
central/project address management
.

The functions can also be used to
search and evaluate:

• Open tasks, e.g. the electrician, 
can be searched.

• Functions are created with short
and long name. (see 2)

• The function can be set per person
by means of a function in the project.

• Functions can be disabled and be
hidden/shown. (see 3) 

3.5 Company/employee functions
• Export: Click on Export to open your 

Explorer. After selecting the storage 
location, import and export functions
as Excel (see 4). 

• Import: select the file to be 
imported and define the column 
for short and long form.

• an Excel with the functions is stored. 

• This is possible centrally as well as 
project-related. 

• Attributes can be copied from other 
projects in the project-related 
address management. (see 5)

• If you hide disabled functions, they are 
not displayed during export. (see 6) 
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3.6 Company/employee attributes

• Select "New attribute" to go to the
mask where you can create your
attributes. (see 1)

• Specify the desired short and long
name. (see 2)

• You can create different types of
attributes: List, Editable list, Integer, 
Yes/No, etc ... (see 3)

• You can define whether the attribute
can be assigned to companies and/or
employees. Accordingly, the attribute
appears in the creation and editing
screens for companies and 
employees. (see 4)

• Confirm your entries with "Add". (see
5) 

Attributes can be created project-related and centrally for employees, 
companies and report items with the toolbox. You can assign them
directly in the Create/Edit Company/Employee screens. 

3.6 Company/employee attributes
The values of the attributes of
type List, Editable list and List of
key/value pairs can be imported
and exported via Excel. (see 6) 
• Import: Select the file to be imported 

and define the column for short and 
long form.

• Export: Click on Export to open your 
Explorer. After selecting the storage 
location, an Excel with the attributes 
is stored. 

• This is possible centrally as well as 
project-related. 

• Attributes can be copied from other 
projects in the project-related 
address management. (see 7) 

• If you hide attributes that have been
deactivated, they are not displayed 
during export. (see 8) 
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3.7 Copying employees

• Use the mouse to drag the employee to be 
copied from the central or project-related 
address management into the "Copy data 
from:" field. (see 1) 

• Add the target company using drag&drop in 
the field "Copy to:". 
(see 2) 

• Click on “do copy" (see 3) to start the query 
which data should be copied. (see 4) 

• Confirm your entry with "OK". (see 5)

You can copy employees to another company using drag&drop or the
"Copy employees" function in the toolbox. The duplicated data record
will not be deleted.

3.8 User defined filter

• Select your search criteria, e.g. 
postcode, attribute, department, etc.. 
(see 1) 

• Click on "Start custom search" to 
activate the search process. (see 2) 

• If several search criteria have been 
selected within a category (e.g. 
company), you can determine whether 
all criteria must be fullfilled or one 
must apply - "Any filter applicable". 
(see 3)

A user-defined filter is available both centrally and project-related in 
the toolbox, which enables you to refine your search according to
further criteria and to display and export the search result. 
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3.8 User defined filter

• To define a new search, you can reset 
the entire filter. 
(see 4) 

• You can export your search results as 
PDF or Excel. (see 6) 

• In the search result you can also display
disabled records. These are also filtered, 
but not exported. 
(see 6) 

• To close the custom filter, click Back to
Toolbox. (see 3)

3.9 Excel Export/Import

You can export and import
your addresses via Excel 
both centrally and project-
related . 

Both functions can be
started via the toolbox. (see
1)

• For the export, select the
desired data (column names) 
(see 2) and click on "Export 
Excel file". (see 3)
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3.9 Excel Export/Import 

• For the import, select the desired
source file using "Open file". (see
4)

• The corresponding Excel column
name can be selected for each
field. (see 5)

• For company and employee
telephone numbers, e-mail
addresses and company functions, 
required fields can be added and 
the type selected. (see 6)

• Click "Import" to start. (see 7)

3.10 Import / sync with other programs

• Synchronization options:
• From PROMAN X to Coor

• From Outlook to PROMAN X

• From Access to PROMAN X

• Once the settings have been
made, the imports or
adjustments can be started
at any time via the toolbox. 

In the central address administration, you can import or sync
the following programs.

Under Tools -> Settings, you can access the
Mask to change the settings. 
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4. address management in the project

Under Tool -> Central Address Book

• Company addresses can also only be created in 
the project.

• As a general rule all companies are created in 
the central address administration. Only if it is
required should you create it in the individual 
project.

• Addresses can be transferred to the central
address management.

4. address management in the project
The following features
are available in the
address management in 
the project: 

• View of the central
address management
incl. search function (see
1)

• Project-related addresses
incl. classic 
Search function (see 2)
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4. address management in the project
• Create and edit companies and 

employees (see 3)

• Functions for companies
and manage employees (see 4)

• The order of the project
partners can be defined via
„manage sort order". (see 5)

• Attributes can be assigned to
companies, employees, and 
report items. 
(see 6)

• Excel Import/Export & PDF Export 
(see 7)

• Employees can be copied and
replaced on a project-by-project 
basis. In both cases, the original 
file is retained. 
(see 8)

4. address management in the project

• Companies and employees that
have been disabled can be
displayed or hidden for
specific projects. 
(see 9)

• The user-defined filter also 
allows you to refine your
search and display filtered
address lists in addition to
the classic search with a 
variety of criteria. (see 10)
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4.1 Importing project partners from the
central address management into the
project
Transfer of centrally
created companies and 
addresses into your
project

• In the opened mask you
can select your project
partners from the central
address management and 
import them into the
project using drag&drop.

• Company (see 1)

• Person/Employee
(see 2)

4.1 Importing project partners from the
central address management into the
project
Company and employee
data transferred from the
central to the project are
greyed out except for the
attributes and "secondary
site of" and are provided
with check boxes (see 1) on 
the side. This status shows
you the standard is adopted
from the central system. By 
deactivating the
checkboxes, you can change
the data any time. The 
change made applies only
to the project. 
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4.2 Project partners Sorting
In the toolbox of your project address management
you can define the order of the project partners with
the button manage sort order

• Is valid for the entire project (e.g. 
participant lists).

• Moving or clicking on a column
redefines sorting.

• You can reset the selected sorting
to the standard sorting at any
time.

• The sorting number can be edited
manually. (see 3)

• Employees can also be moved to
the desired position using
drag&drop. 

4.3 Replacing employees

In the report items and distribution lists of a project, an 
employee can be replaced by another project-related
employee.

• Is valid for the entire project (e.g. 
participant lists).

• Enter the person to be replaced in the 
“Replace data for:" field (see 1). 

• Use the mouse to drag the employee to 
be displayed in the report items and 
distribution lists to the "Copy data from:" 
field. (see 2) 

• Click on “Replace employee" (see 3).
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4.4 Disable inactive datasets

No longer active people can
be disabled in the project.

• Employees can be
disabled and 
reactivated. (see 1)

• Data records that
have been archived
can be shown or
hidden.
(see 2) 

• It is also possible to
disable functions. 

5 report collection
Is a directory for shared information
and contains all reports on a topic. 

• meeting groups
• subject areas

You can create a new report
collection by right-clicking on the
project.
• Important points of management of

the report collection are:
• Collection shortname: a unique ID of

the collection (see 1) 
• Collection longname: Display in 

program (see 2)
• Document path (optional, but very

helpful) (see 3)
• Default setting for PDF output, 

this path is suggested when
saving logs in PDF format.

• Print settings are accessible in 
section 4 (more detailed
information on slide 13.1).
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5.1 Report collection
Copying Print Settings

All print settings of the report collection

can be easily copied from another report 
collection.

In the right toolbox of the report collection
you can select the collection from which
everything should be copied.

With „Copy settings and save" all print
settings are copied.

5.1 report Collection 
print settings
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6. Attributes
• are freely definable keywords

• can be assigned to any point

• can optionally be displayed in the printout

• to highlight important information to the reader

• Specific search

• Easy and fast search, e.g. all points concerning

additional costs

• Creation of filtered reports, e.g. decision list

Example printout

6.1 Creating Attributes

Accessible via File -> Manage central
attributes or project-related -> Manage 
attributes in toolbox)
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6.1 Creating Attributes

• Click on "New attribute" to
open the editing mask (see 1). 

• Insert the short and long
name (see 2).

• To assign an attribute to a 
report item, it must be of the
type list of key/value pairs (see
3). 

• Enter the values of the
key/value pair and click on 
"Add list" to add the value (see
4).

• Allows the attribute to be
added to a report item by
clicking the checkbox (see 5).

• Attributes can be printed in 
short and/or long form (see 6) 

7. chapter structure
With a right mouse click on Report collection you can
edit your chapter structure (see 1). 

• You can edit created chapters simply by clicking on 
them, as well as create subchapters with the right
mouse button.

• positioning can be controlled by drag&drop or right
mouse button

• With new chapter (see 2) you create new chapters

• With the right mouse button further functions can
be reached e.g. move chapters, create subchapters, 
change chapter level.
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8. Create reports
Right-click on the report collection to
go to „new report".

All fields are optional. However, all 
that are filled appear on the printout. 

• Subject, date, time

• In the Header  tab: meetingleader
and author as well as the
meetingplace

• You can also edit the report later by
right-clicking on the report -
„manage report".

• When you create the report, all open 
report items are automatically
included in the new report. 
No report items are lost, the agenda
is automatically created for you.

For further registers see continuation
foils.

8.1 Report General Data Printout
If the fields are not filled in, the following fields automatically slide together, e.g. if the leader is not 
filled in, the author moves to the upper line.
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8.2 Report: Text blocks
In the textblocks tab, you can insert your
textblocks at different points in the
report. These are automatically
transfered from report to report, but can
be changed report-specifically.

• In 1, you've got the list of the
textblocks that are active in the report

• Using drag & drop these can be pulled
to the desired position. 

• Editing takes place in the menu
„manage textblock templates" (see 2).

8.3 Report: Next meeting

On the Next Meeting tab, you can input

your next meeting data.

• Mandatory fields: none

• Optional - but important fields:

• Date (see 1)

• Time (see 2)

• Meetingplace(see 3)

• Positon on report: 
• On cover

• End of report

• Don‘t show

• You can design your own next meeting
template,which you can select in the print
template field (see 4)

Textblocks

Standard
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8.4 8.4 Protocol view

• The protocol view enables
the preview of the report and 
the processing of all essential 
information.

• This view does not yet
correspond 100% to the
printout. 

8.4 Protocol view: direct editing

• Most fields can be edited
directly in the protocol view (e.g. 
see 1).

• Project participants can simply
be dragged into the fields. 

• Control information is colored
blue (see 2), from left to right
• The hand to move the person

• The pen to edit

• Set as standard distributor (i.e. the
person is automatically taken
along to the next session)

• X to remove the person on the list.
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8.5 Protocol view: Participant and 
Distribution list
• The distribution list defines

the list of participants who
have attended the meeting

• The desired project
participants can simply be
dragged & dropped from
the left list to the
participant distribution list
(1)

• With the "hand" (2) these
can be pulled to the
desired position

• Columns are defined in the
layout and can be changed.

8.5.1 Participants / distributor: 
extended settings

Click on "Manage participants" in 
the toolbox (see 1) or right-click on 
the desired report to open the 
advanced settings of the 
participants /

distribution lists. 
(see 2). 
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8.5.2 Participants / distributor: 
extended settings

The administration of the participants consists of three areas:
• Project address book (see 1): Simply drag and drop participants into your

distribution list (see 2) and define their attendance.

• use the toolbox to edit the desired sort order and add involved persons (see 3). 

8.5.3 Participants / distributor: 
extended settings
• The project address book contains

the following functions:
• The employee view shows you all 

project partners. In the main view, 
the project partners are grouped
by company.

• Filter by all project partners or a 
specific report collection(see 1). 

• A further distinction can be made
by filtering by a single report (see
2), e.g. all participants of the old
session. 

• In the search field you can also 
directly find the desired company
/ person.
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8.5.4 Participants / distributor: 
extended settings
• Distributor: Defines the distribution group of the document. Also used for

automatic e-mail transmission of the report (see 1). 
• The attendance can be augmented with „partially present" or replaced by

"excused" (see 2). For these to be printed, a corresponding print template
must be set.
• The sorting can be changed by drag & drop. 
• All Employees with a checkmark are automatically entered in the next session

(see 3). 

8.5.5 Participants / distributor: 
extended settings
• The following actions are simplyfied

using the toolbox:
• Involved persons who, are registered 

as responsible for a report item can
be added to the list in their entirety
(see 1). 

• With one click the status for all 
participants can be defined (see 2). 

• The sorting can be done from the
project-related address management
or from the last report (see 3). 
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8.6 Protocol View: Create and Edit 
report item
• Report items can be created with (1) in the desired chapter.

• With (2) subreport items can be created to the desired report item.

• With (3) you can change the chapter of the reportitem.

• With (4) you can paste
Pictures or attachments
into the report item
from the clipboard

8.6 Protocol View: Create and Edit 
report item
• With a click in the text field, the

current information on the report
item can be entered / edited.

• Involved can be placed on the 
right using drag & drop.
• (1) is an post appointment

• (2) is the main responsible

• X for deleting the involved person

• With or without target date
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8.6 Protocol View: Create and Edit 
report item
• Points can be easily hidden

by clicking the printer icon (1)

• individual entries from the
history can also be hidden (2)

8.6.1 Report item
Create & Edit

A report item corresponds to a task / information in a session. 

• With a right mouse click (see 1) on the report, you can create a report
item in the report.

• Existing report items can be opened and edited with a right mouse
click (see 2) on the report item or via the protocol view (see 3).

open
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8.6.1 Extended report item settings
• Mandatory fields:

• Short name (title) 
(see 1)

• Status (see 2)

• Optional Fields:
• Photos (see 3)

• Attachments (see
4)

• Involved (see 5)

8.6.1 Extended report item settings
• Report item Text can be entered in the text field:

• Formatting (see 1)

• Spell check inline (see 2)

• Involved persons can be added to the report item using drag & drop (see 3).

• In addition, you can set the following for each already selected involved person (picture

below):

• Main responsible

(see 4)

• Completed to be

(see 5)

• Completed is

(see 6)

• Post appointment

(see 7)
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8.6.1 Extended report item settings

• can be defined in the print settings of the
report collection
• Same as in report item
• Person / Company / Function
• Shortname / Longname

ATTENTION: when printing, there is a limited 
space, i.e. do not print too much e.g. company
& person & function with longname is not 
possible!

8.6.1 Advanced
report item settings

The number of printed historical report items
can be generally defined in the report collection. 

Here you can define which historical report items
are to be printed. This number cannot be greater
than the generally defined default. 
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8.7 Protocol View: report item Status
• one-time info

• Printed only in the current report

• Permanent Info

• applies to all reports until deletion

• Text can be changed per report

• open

• in progress

• Closed on

• canceled

• deferred to (or resubmitted)
• Reminder function: The item in the current

session is printed out once, then hidden
until the specified date.

• Your own status: you can easily create
your own status in the report
management, for example:
• Decision, CRQ

• Open in the colours (red, orange, green) ...

8.8 Protocol view: 
Pictures and attachments
• Images can be placed above

or below the text using drag
& drop.

• With (1) the position of the
image can be changed.

• With (2) the image can be
further edited (cut, mark,..).

• PDF attachments can be
added to the report item 
using drag&drop.
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8.8.1 Advanced Settings: 
pictures
• Images can simply be dragged and dropped

into the respective image fields (see 1).

• They can be placed both before and after 
the text.

• Further settings can be made via "Manage 
report item images" in the toolbox (see 2).

• The images are automatically stored in the
database. The size is reduced in order to
achieve an optimal Memory & Quality ratio. 

8.8.1 Advanced Settings: pictures
Via "Manage images" you determine:

• the width of the photo in the printout
(see 1):

• like text block

• from text to right pagestop

• entire page width

• to select the desired storage location or
load images from the clipboard (see 2).

• You can insert two images next to each
other. 

• Title of the image (see 3)
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8.8.1 Advanced Settings: 
pictures
• In the tab „Imageeditior" (see 1) you can

quickly and easily adapt your photos and 
plans:
• Cutting (see 2)

• Insert text and shapes (see 3) 

• Set markers with drag&drop (see 4) 

• Undo all changes (see 5) 

With this feature, you can directly highlight 
relevant image sections, plans, positions, 
defects, before-and-after statistics much
more visually.

8.8.1 Advanced Settings: pictures
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8.8.2 Advanced
Settings: attachments
• Attachments can easily be dragged & 

dropped into the field (see 1)

• Or via "Manage report item 
documents" (see 2) further settings
can be made
• By ticking the option, the document can be

saved in the database (see 3).

• this version of the document is saved
unchanged in the report! 

8.8.2 Advanced
Settings: attachments
• Points can be supplemented

with attachments
• PDF are also printed and stamped

with the report item code.

• all others are automatically
included with the e-mail dispatch



10.12.2019

41

8.9 Protocol View: Video Short Training

• More information about the new reporting mask can be found
in the training video at 

http://www.proman.at/tutorials/intuitiv-protokollieren/

9.1 Changing report item number

• Report item number
• is consecutive per report

• Unique for the report
collection

• Consists of
• Report number

• Report Item number

• Change number
• It is only possible in the selected report

• The report item must have been
created in this report
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9.1 report item number: Structure

• First occurrence of
item
• Item number

• Item will be
continued
at further meetings
• Report number

• Date of meeting

Chapter / Report number / Item number

9.2 Comments in the report & Meeting 
preparaton

In the comments you can write
your notes for the next report

• Comments are not printed , you
can only print them in the
meeting preparation
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9.2 Comments in the report &
Meeting Preparation

Allows you to create notes for your next report.

Space for handwritten Notes

9.3 report item Load&Delete
• With the option „Load 

report items“ you can
inclued report items from
previous reports
• For example,a report item 

was marked as closed but 
you need it again in the 
current report. 

• „Delete report item“:
• Deletes the report item from

the current report.
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9.4 report items: attributes

Attributes can be managed via the
toolbox in the report item  „Assign
report item attributes". 
(see 1) 

• Choose the desired attribute in 
the dropdown menu(see 2)

• Define the value of the attribute
with which the report item is to
be marked. 
(see 3)

9.5 report item: beamer view

You have the option of
presenting your reports live 
during meetings. The report
items are displayed
synchronously in a second
mask and can be presented
e.g. on a beamer.

• Images and documents
can be opened with a 
double click
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9.6 import report items from another
report collection or project
Report items can be taken
from another project or
report collection.

This can be very practical for
example the continuation of
report items with a reference
to the item source. 

Right-click on the report to
open the "Import report
items" function. (see 1)

Select the desired source 
project, report collection and 
report from which the items
are to be loaded. (see 2) 

The search allows you to search for
a specific report item title and 
content. (see 1)

Select the items to be imported
individually (see 2) or all at once. (see
3) 

9.6 import report items from another
report collection or project
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Individual import options can be defined for the selected report
items:

9.6 import report items from another
report collection or project

You can insert the report items with or without source reference

• Without source reference: report item template with which you always
start new projects

• With source reference: to further discuss the report item in other
sessions.

9.6 import report items from another
report collection or project
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9.7 Report item: Text and involved
Examples

With the Agenda function, invitations with agenda 
data can be created and automatically sent.

The function can be accessed with the right 
mouse button on the report collection / "Edit next 
agenda".

The agenda of an already generated report can be 
reached directly by right-clicking on the desired 
report.

9.8 Invitation & Agenda Function
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A new tab will then open. The following settings can be made there.

• Name and appointment date

• Invited with time and comment

The entered data is automatically copied to the next agenda.

9.8 Invitation & Agenda Function

In the toolbox you can select which elements should be used to create 
the agenda list. After clicking on "Add selected", the agenda is 
automatically created in the "Free text" tab. This can then be edited 
manually:

9.8 Invitation & Agenda Function
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10. Types of output

• Right mouse click on the
report - select „ print report
as PDF".

• PDF attachments are
automatically created together
with the report in a file, so no
attachments are lost.

• Send email  

• reports

• attachments

10.1 E-mail: dispatch

Right-click on the report and 
select Send e-mail (see 1).

• Choose between "Use text
blocks" or "Free text" (see 2). 
With predefined text blocks you
save time when sending!

• The subject is filled
automatically, if desired - select
the format for "Edit standard
subject" once (see 3).

• When using text blocks, a 
preview of the final text is
created (see 4).
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10.1 E-mail: dispatch

• The report is
automatically attached
to the e-mail.

• You can manage 
additional attachments
(see 2).

• The distribution list is
taken from the
subscriber/distributor
of your report and can
be edited individually
(see 1). 

10.2 Sending an e-mail:
text blocks

• enable fast and 
standardised
transmission of
reports
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12. evaluation

Default: all content available

12. evaluation
• filter options

• folders

• report collections

• reports

• Report items

• item status

• Involved

Companies

person

• Keywords (free text) 

• Attributes 
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13. Project-Cockpit

Via View -> "Show 
Project Cockpit" you
can access your
individual task
management for
your project. 
(see 1).

Here you have an 
overview of all tasks!

13. Project-Cockpit
• tasks are automatically

generated from the report
items of the current reports of
your project (see 1).

• You can filter by involved (see
2).
• By right clicking you can open 

the report item editor. 
• Add a reminder and the task will 

be displayed in the agenda on the
reminder day (see 3).
A reminder is marked with the
symbol. 

• If no reminder is added, the task
will appear in your agenda 7 days
before the target finish date.

• If a start is entered, the task also 
appears in the time axis "Calendar
view 2".
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13. project cockpit
• Reminders can easily be

created independently from
the current reports using
"Create todo" in the toolbox 
(see 1). 

• Drag the desired project
partner (see 2) into the task
window (see 3).
• Choose between the options 1) 

Phone call, 2) E-mail, 3) To-Do -
the data such as e-mail address
and phone number are
automatically taken over and 
called up when you click on the
icon (see 4).

• On the reminder date, the tasks
appear in your agenda. (see 5). 

• Tasks can be marked as
completed. If the project cockpit
is updated (see 6), the completed
tasks are removed from the list. 

13. Project-Cockpit
• Meetings are displayed in 

your agenda and calendar
(see 1).
• In the current report, 

under Next Meeting, add
the date and time. 

• There are two calendars in 
your project cockpit for a 
better overview. 
• Classic day view for task

management (see 2) 

• Calendar with timelines to
display your project
progress (see 3)

calendar view



10.12.2019

54

14. Example: printout of participants
list

Templates are customizable

Template Example 1, e.g:

• email address

• Temporary presence

Template Example 2

• Invitation column for
the next report

14.1 Report Collection: 
Print Settings 1

• Different print settings can be assigned to each
report collection. Thus, for example, file notes
can be printed differently than construction
meetings.

• In the toolbox (see 1), the individual settings can
be specifically changed.

• If a template already exists, the settings can also 
be completely adopted from another project or
report collection (see 2). 
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14.2 Report Collection: Print Settings 2

Important Settings in the
report item settings Tab

• Start printing items on cover - if
you have listed only a few
participants, this allows you to
start with your report items
on the first page of the cover
page.

• If you wish, you can select the
salutations for the names of
the participants or
distribution list

14.3 Report Collection: Print Settings 3

Important Settings in the
Report Contents Tab
• All chapters in which report items are

printed are printed as a list at the beginning.

• Sorting of the report items by item number
or by chapter (see following foil)
Note: When sorting by item number, the
chapters are not printed.

• Printing range of the report items

• only the last e.g. 5 entries to this point
and or where text is contained (see
following slide)

• Important for report items that
remain open for a long time and are
discussed again and again. 
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14.4 Example printout sorting
by item number and chapter

14.5 Report collection: 
Print Settings 4
• Formatting of the item code:

• chapters Short form

• report collection Short form

• item or report number only

• Print view of involved
persons in report items: 
same as in report item, 
person, company, function, 
short or longname

• The report can contain
various status types : Info, 
permanent Info, open, in 
progress and closed
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14.6 Examples printout
Representation of the item code 

Report collection
shortname

Chapter Code

14.7 Examples printout
Mention of the involved in the report item

Same as in report item Person & function
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14.8 Report Collection: Print Settings 5

• Under schedule color-settings, 
overdue or due appointments
can be highlighted in color

• You should always define the
header and footer in the project
as a whole, but if you want to
add the client's logo in a report
collection, for example, you can
override the project settings in 
the print settings for this report
collection.

14.9 Example printout:
New meeting content bold and 
appointments highlighted in color
according to due date
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14.10 Examples printout:
Change status settings & create your own 
statuses
• You can easily change the formatting of existing statuses

• In the bottom line you can create your own status at any
time, e.g.
• Decision, CRQ, determination

• Open with traffic light colours (red, orange, green)

15. print layout

• Creation of templates for
• Front page

• Report core data

• Participants

• Report content
• chapters

• Report item

• Standard templates are
included. If nothing else is
defined, these are used.
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15.1 Print Layout: report core data

• Select desired template

• Standard templates cannot be
edited
• If desired, a copy can be made for

further processing.

15.1 Print Layout: report core data

• Fields can easily be extended
• Free text

• data field

• positioning
• On cm position

• Using the neighbouring fields
(e.g. to the right of ..)
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15.1 Print Layout: report core data

• The data fields make it easy to
automatically print data from
the project core data.

• At runtime the placeholder is
replaced with the correct data
of the project

15.1 Print Layout: report core data

• The fields can be easily
positioned

• Empty fields can be hidden

• Font can be configured per 
text, element or entire cover
sheet
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15.2 print layout: participants / 
distribution list

• The columns can be freely
defined
• content

• title

• width

• font

15.3 print layout: temporary

1. Add the „temporary" 
column to the template

2. You can enter the time from
/ to in the participant list
(the exact time is not 
required).

3. Expression: The new
column shows the
participant who is only
temporary in the session.
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15.4 print layout: chapters

Design of chapters :
• font

• Bold, italic, underline

• background color

• Per level

15.5 printlayout: report item
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16. user administration and rights
control

• With the link admin
(PM_Admin1.exe) possible
• Login as "Administrator

• User
• create

• delete

• Change password

• release a blocked license

16.1 User Administration

• New
• Create user

• Delete
• Delete user
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16.1 Benutzer Verwaltung

• Set Offline:
• Release license if it is still 

locked (e.g. after a crash)

• The user has an active status
in the "Online" column.

• To set offline: 
• Select user

• then click on "Set Offline".

16.2 Rights control

• General rights management
• In PM_ADMIN1.exe!! 

• Rights control in the project
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16.3 Rights control: General

• Rights control for
• administrator

• Create projects

• Delete Projects

• Edit Layout

• Assign layout

• Central address
management

• Regulates the general rights of users
in the program

16.3 Rights control: General

• Setting for project visibility
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16.4 Rights control: in the project

• Rights restricted per project
and/or at report collection
level

• rights
• Admin
• lock
• read
• change
• input

• Rights can be
• restricted

• unrestricted

17. mobile operation

• in stationary operation, 
projects can be transferred
into mobile mode or back at 
any time

• projects can be opened in 
mobile mode and also edited
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17. mobile operation

• Start laptop mode
Select a project that you want

to transfer to mobile operation.

You can also transfer several
projects at the same time.

17. mobile operation

• Select data with the
appropriate rights
• Editable

• I.e. the data can be edited in 
laptop mode.

• Read only
• This means that the data cannot

be edited in laptop mode. The 
address book is also not editable
in this case.

• Attention: You can not create
a project in mobile!



10.12.2019

69

18. Import / Export

• Allows data to be exported or
imported into report collections

Export can be used for

• Creation of reports from several
persons

• Data exchange with partners for
further evaluations

• Transmission to AG with restricted
reading rights and without
comments

18.1 Export

• Select the desired report
collection
(see 1)

• The report collection can
be exported with read-
only rights, if required
(see 2) 
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18.1 Export

• Define the advanced
export settings (see 1) 
• employees

• attributes

• attachments

• comments

• Free texts

• The export path can be
defined individually (see
2) 

18.1 Import

• When importing the
report collections, you
can define how you want
to import them:
• Import as new project

• Import into existing
project
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18.1 Import

• The following can be
defined in the target
project
• Import with new folders

into project
• Import as new collection
• Replace project

properties
• Merge folders with same 

short name
• Overwrite existing

collections with same 
short
• Replace similar addresses

For questions:

• web page
• http://www.proman.at

• Documents
• tutorial
• training documents

Accelerate report creation, management, and 
delivery!

Save time with PROMAN.

• PROMAN Support Team
• @ support@proman.at

• Hotline 
• International +43 1 478 05 67

• from Germany 0800 589 0129


